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1 1. Overview 

What is inDART-STX? 

inDART-STX is a powerful entry-level tool for STMicroelectronics ST7-based 
systems. inDART-STX takes advantage of STMicroelectronics STVD7 
(STMicroelectronics Visual Debug) Integrated Development Environment and 
the ISP (In-Circuit Programming) feature to program the FLASH memory of the 
ST72F family of microcontrollers. Together with STVD7, inDART-STX provides 
you with everything you need to write, compile, download, in-circuit emulate 
and debug user code. Full-speed program execution allows you to perform 
hardware and software testing in real time. inDART-STX is connected to the 
host PC through a USB port, while the 10-pin probe of the product fits into the 
target's standard ISP connector. On Design Kit packages, a full-featured 
experiment board for a specific ST7 microcontroller is also included. 
inDART-STX offers you the following benefits: 
 
§ Real-time code execution without probes–works with all packages; 
§ In-circuit debugging; 
§ Built-in FLASH programmer (DataBlaze programming utility); 

§ Supports both XFlash (EEPROM-based, single-voltage) and HDFlash 
(FLASH-based, dual-voltage) devices; 

§ Standard chip used–no bondouts, 100% electrical characteristics 
guaranteed; 

§ Working frequency up to the microcontroller’s maximum; 

§ STMicroelectronics Visual Debug user interface (the same user interface of 
all STMicroelectronics ST7 tools), with integrated C compiler and assembler 
and source level and symbolic debugging; 

§ Hardware self diagnostic test. 

ST FIVE Support 
The inDART-STX debugger unit also supports ST FIVE FLASH devices. To use 
the inDART-STX debugger unit with ST FIVE devices, just download the 
“inDART-STX for ST FIVE” software from our website 
(http://www.softecmicro.com/download.html). 



1. Overview 

Page 6 

1 What is In-System Programming (ISP)? 

The ISP feature allows you to update the content of FLASH program memory 
when the chip is already plugged on the application board. ISP uses the ICC (In-
Circuit Communication) serial protocol to interface a programming tool like 
inDART. The ISP feature can be implemented with a minimum number of 
added components and board area impact. 

inDART-STX uses the standard, 10-pin ST7 ISP connector to program and in-
circuit emulate the target device. You must therefore provide such connector 
(see the diagram below) on your target board. 
 

 
The ST7 ISP Interface 



inDART-STX User's Manual 

Page 7 

1 ISP Pin # Pin Name ISP Pin # Pin Name 

1 GND 2 ICCDATA 

3 GND 4 ICCCLK 

5 GND 6 RESET 

7 VDD 8 ICCSEL/VPP 

9 OSC_CLK 10 NC 

The ST7 ISP Connector 

§ ICCDATA: In-Circuit Communication input/output serial data pin. 
§ ICCCLK: In-Circuit Communication serial clock input/output pin. 

§ ICCSEL/VPP: ISP Entry Mode/Programming voltage. Please note that, on 
some devices (e.g. ST7FLITE0), the ICCSEL/VPP line is not available. 

§ OSC_CLK: Used to provide a device input clock signal to use when no 
other clock sources are available. Depending on the target device, inDART-
STX provides a 4- or 8-MHz signal on this pin. 

§ RESET: Device reset (input/output). 
§ VSS: Device power supply ground. 

§ VDD: Device power supply voltage. This voltage is provided by the target 
board to inDART-STX, which in turn uses it to properly generate the 
ICCDATA, ICCCLK, OSC_CLK and RESET signal voltage levels. 

 

 
Note: if the RESET, ICCCLK or ICCDATA lines are used for other purposes in 
the application, a serial resistor has to be implemented to avoid a conflict in 
case one of the other devices forces the signal level. If these pins are used as 
outputs, the serial resistors are not necessary. 
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1  
Note: as soon as inDART-STX is plugged to the target board the ICCCLK and 
ICCDATA lines are not available for the application. 
 

Demo Boards 

On Design Kit packages, a full-featured, microcontroller-specific experiment 
board is also included. The demo board can be used for evaluation/experiments 
in the absence of a target application board. 

STVD7 Integrated Development Environment 

The inDART-STX user interface is based on the ST7 Visual Debug Integrated 
Development Environment (STVD7). STVD7 enables programs to be executed 
and stopped where desired, while viewing the memory contents. It offers the 
ability to step through and examine code at the C source level and the Assembly 
instruction level. You can introduce breakpoints and run or single-step the 
executable, while viewing the source and observing current program values. All 
registers and memory locations are accessible for both read and write 
operations. This documentation covers the basic setup and operation of the 
STVD7, but it does not cover all of its functions. For further information, please 
refer to the STVD7 on-line help. 

Metrowerks (ex Hiware) and Cosmic Demo Versions 
Each of these two third-party companies have developed a C compiler for use 
with ST7 microcontrollers. For more information on how to obtain a free demo 
version of both compilers, please refer to the STMicroelectronics website, 
http://www.stmcu.com, or go directly to the Metrowerks 
(http://www.metrowerks.com) or Cosmic (http://www.cosmic-software.com) 
websites. 

Metrowerks CodeWarrior 

As an alternative integrated development environment, you can use Metrowerks 
CodeWarrior for STMicroelectronics Embedded Systems. It includes an editor, 
assembler, C compiler, linker, debugger and works smoothly with inDART-STX. 
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1 For more information about CodeWarrior for STMicroelectronics Embedded 
Systems please refer to Metrowerks website (http://www.metrowerks.com). 

Recommended Reading 

This documentation describes how to use inDART together with the STVD7 
Integrated Development Environment. Additional information can be found on 
the following documents: 
 

§ STVD7 Online Help—The ST7 Visual Debug online help. 
§ AST7-LST7.PDF— This user’s guide describes how to use the 

STMicroelectronics assembler, linker, formatter and librarian for the ST7 
family. 

§ ST7 FAMILY 8-BIT MCUs Programming Manual—Programming 
reference containing the description of the full ST7 instruction set. 

§ ST7 Family Data Sheets. 

§ RELEASE.TXT—Contains notes and known problems about the STVD7 
user interface. 

§ inDART-STX for ST7 User’s Manual Addendum—Contains detailed, 
device-specific information not present in this printed version. It’s available 
in PDF version and can be accessed from the inDART-STX user interface. 

Software Upgrades 

The latest version of the inDART-STX user interface is available for free at our 
download page on the web: http://www.softecmicro.com/download.html. 
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2 
2. Getting Started 

inDART-STX Components 

The inDART-STX package includes the following items: 
 
1. The inDART-STX in-circuit debugger/programmer unit; 
2. A 20-cm, 10-conductor ISP cable; 
3. An USB cable; 
4. The inDART-STX “System Software” CD-ROM; 
5. This user’s manual; 

6. A full-featured, microcontroller specific experiment board (on Design Kit 
packages only). 

 

1 

2 3 

4 

5 

6 
 

The inDART-STX Package 
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Host System Requirements 

The inDART-STX in-circuit debugger is controlled by a PC user interface 
running under Windows. The following hardware and software is required to 
run the inDART-STX user interface: 
 

1. A PC compatible system running Windows 98, Windows Me, Windows 
2000 or Windows XP; 

2. 64 MB of available system RAM plus 40 MB of available hard disk space; 
3. An USB port; 
4. A CD-ROM drive (for installation). 

Installing the Software 

The inDART-STX user interface setup program is located on the SofTec 
Microsystems “System Software” CD-ROM provided with the instrument. The 
setup program will copy the required files (including the USB driver) to your 
hard drive. 
To install the inDART-STX user interface: 
 
1. Insert the “System Software” CD-ROM into your computer’s CD-ROM 

drive. 

2. A startup window should automatically appear (if the startup window 
doesn’t appear automatically, manually run the Setup.exe file located on 
the CD-ROM root). Choose “Install Instrument Software” from the 
main menu. 

3. A list of available software should appear. Click on the “Install inDART-
STX for ST7” option. 

4. Follow the on-screen instructions. 
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Note: the setup program will offer you the option to install the inDART-STX 
plug-in for Metrowerks CodeWarrior for ST7. This option only works if you 
have Metrowerks CodeWarrior for ST7 already installed in your system. By 
installing the inDART-STX plug-in for Metrowerks CodeWarrior for ST7 you 
will be able to use inDART-STX’s debugging capabilities from within the 
CodeWarrior IDE. 
 
 

 
Note: if you are installing the inDART-STX user interface on Windows 2000 
or Windows XP you must have logged in as Administrator. 
 

Installing the Hardware 

The inDART-STX in-circuit debugger is connected through an USB port to a PC 
which runs the inDART-STX user interface as explained later. Connection steps 
are listed below in the recommended flow order: 
 
1. Install the system software as described in the previous section. 
2. Insert one end of the USB cable into a free PC USB port. 

3. Insert the other end of the USB cable into the USB connector on the 
inDART-STX board. The green “POWER” LED on the instrument should 
turn on. Windows will automatically recognize the instrument and will load 
the appropriate USB driver. 

4. Insert one end of the ISP cable into the ISP connector on the inDART-STX 
board. 

5. Insert the other end of the ISP cable into the ISP connector of the demo 
board or target application. 

6. Turn on the power to the demo board/target application. 
 
Please refer to the following figure to get an overview of the inDART-STX unit. 
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1 2 

3 4 

1.  USB Connector 
2.  ISP Connector 
3.  “POWER” LED 
4.  “BUSY” LED 
  

The inDART-STX Unit 

 
Note: both Windows 2000 and Windows XP may issue a warning the first 
time inDART-STX is connected to the PC. This warning is related to the fact 
that the USB driver used by inDART-STX is not digitally signed by Microsoft, 
and Windows considers it to be potentially malfunctioning or dangerous for 
the system. However, you can safely ignore the warning, since every kind of 
compatibility/security test has been carried out by SofTec Microsystems. 
 

Application Tutorial 

This section will provide a step-by-step guide on how to launch your first 
inDART-STX project and get started with the inDART-STX user interface.  
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Note: the example provided assumes that inDART-STX is used with the IDB-
ST7FLITE0 demo board. If you have a different demo board, some procedures 
may change slightly. This tutorial is based on an Assembly example. 
Additional examples in C (based on  the Cosmic C compiler) are also provided. 
 
 

The sample application configures the A/D peripheral to convert on the A/D 
channel connected to the potentiometer and displays the results on the LEDs. 
 

§ Ensure that inDART-STX is connected to the PC (via the USB cable), to the 
demo board (via the ISP) connector, and that the demo board is powered 
on. 

§ Make sure that the “CLKIN SEL” jumper on the demo board selects the 
“ICC” mode. 

§ Make sure that all of the “LED ENABLE” jumpers and the 
“POTENTIOMETER ENABLE” jumper are inserted. 

§ Start the inDART-STX user interface by selecting Start > Programs > 
SofTec Microsystems > inDART-STX > ST7 > STVD7 for inDART-
STX. The first time you launch the inDART-STX user interface you are 
prompted to enter the toolchain paths to be used by STVD7’s integrated 
development environment. Click “Yes”. The following dialog box will 
appear. 

 

 
The Toolchain Path Dialog Box 
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§ Click “OK”. The inDART-STX user interface will open. 

§ From the main menu, choose File > Open Workspace. Select the 
“adc.wsp” workspace file that is located under the “\Program 
Files\SofTec Microsystems\inDART-
STX\ST7\STVD7\Samples\Asm\LITE0\Adc” directory. Click 
“Open”. 

§ The application has already been assembled and the executable file 
generated. From the main menu, choose Debug > Start Debugging. The 
user interface will display the source code with the Program Counter 
pointing to the first instruction, alongside of the Disassembly window. 

 

 
Debugging Session Started 

§ From the main menu, select Debug > Run. The program will be executed 
in real-time. Please note that the “BUSY” LED on the inDART-STX unit 
turns on. By rotating the potentiometer on the demo board, you affect the 
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results of the A/D conversion, and the binary value of each conversion is 
displayed on the LEDs. 

§ From the main menu, select Debug > Stop Program. The application will 
stop, and the Program Counter arrow will point to the next instruction to be 
executed. 

§ From the main menu, select View > ST7 Registers. A small window 
displaying the current value of all of the ST7 registers (Program Counter, 
Stack Pointer, Index Registers, etc.) will appear. 

§ From the main menu, select View > Peripheral Registers. A small 
window displaying the current status of all of the ST7 built-in peripherals 
(I/O ports, Timers, A/D converter registers, etc.) will appear. 

§ On the source code window, set a breakpoint on the “ld A, ADCDR” 
instruction. To do so click on the line containing that instruction and then, 
from the main menu, select Edit > Insert/Remove Breakpoint. A solid, 
red circle will appear on the leftmost column indicating that the breakpoint 
has been set. 

§ From the main menu, select Debug > Run. The application will restart, 
and will automatically stop at the previously set breakpoint. 

§ From the main menu, select Debug > Step Into. This command will 
execute the “ld A, ADCDR” instruction. On the ST7 Registers window, you 
can see how that instruction affected the value contained on the 
Accumulator. This value is the result of the A/D conversion. 

§ Issue another Step Into command (Debug > Step Into). The Accumulator 
value will be displayed on the LEDs. 

 

Congratulations! You have successfully completed this tutorial! You can 
continue to experiment with the inDART-STX user interface and discover by 
your own its potentialities. For an in-depth guide of all of the user interface 
features, select Help > Search from the main menu. 
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3. inDART-STX Operations 

inDART-STX Working Principles 

inDART-STX is an in-circuit debugger as well as a programming tool. It 
programs files into the ST72F microcontrollers and offers debugging features 
like real-time code execution, stepping, and breakpoint. Its debugging features 
are achieved thanks to either: 
 

§ An integrated on-chip debug module (available on some devices, such as 
ST7FLITE2) which allows for breakpoint handling, run/stop, etc. 

§ A small portion of monitor code which is automatically and transparently 
added to the user code and programmed into the target microcontroller. 
The monitor code has been developed by SofTec Microsystems for devices 
without on-chip debugging capabilities. 

 

Both the on-chip debug module and the downloaded monitor communicate with 
the host PC through a bidirectional, command-based protocol via the ICCDATA 
and ICCCLK lines of the microcontroller. For this reason, the ICCDATA and 
ICCCLK lines are reserved during debugging sessions. The same two lines are 
also used during device programming. 

Contrariwise to traditional in-circuit emulation (where the target application is 
executed and emulated inside the emulator), inDART-STX uses the very same 
target microcontroller to carry on in-circuit execution. This means that all 
microcontroller’s peripherals (timers, A/D converters, I/O pins, etc.) are not 
reconstructed or simulated by an external device, but are the very same target 
microcontroller’s peripherals. Moreover, the inDART-STX debugging approach 
ensures that the target microcontroller’s electrical characteristics (pull-ups, low-
voltage operations, I/O thresholds, etc.) are 100% guaranteed. The trade-off, 
however, is that the target microcontroller must be properly configured and 
ready to execute target applications. 
 



3. inDART-STX Operations 

Page 20 

3
 

inDART-STX Working Principle 

Limitations 

Since inDART-STX is based on the ISP feature of the ST72F family of 
microcontrollers, some on-chip resources are wasted for debugging purposes. In 
particular, during debugging the ICCDATA and ICCCLK lines are always 
reserved for emulation purposes. 

Additionally, inDART-STX takes advantage of all of the on-chip debugging 
features (if present) of the specific microcontroller under emulation. 
Consequently, for each microcontroller supported by inDART-STX, there is a 
series of specific limitations that have to be accounted for during the debugging 
process. Please refer to the inDART-STX online user’s manual addendum for 
detailed information. 

Configuring the MCU 

Before to start a debugging session, you must define and configure the target 
device (MCU) you wish inDART-STX to emulate. The target device is defined 
and configured from the MCU Configuration dialog box. To access it, select 
Tools > MCU Configuration from the main menu. The following dialog box 
will appear. 
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The MCU Configuration Dialog Box 

inDART Model Settings 
First of all, verify that the inDART model corresponds to “inDART-STX”. The 
“Settings” button then allows you to set up detailed parameters used by 
inDART-STX to perform its debugging activities. 

All of the inDART-STX debugging and programming capabilities rely on the ICC 
(In-Circuit Communication) mode of the target device. In order to enter this 
special mode (which establishes a communication channel between the target 
device and inDART-STX through the ICCDATA and ICCCLK lines) and 
configure it properly, a few parameters must be correctly specified. 
By clicking the “Settings” button the following dialog box will appear: 
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The Settings Dialog Box 

The “ICC Mode Entry” section, the “Target RESET Rise Time” parameter and 
the “Embedded Command Frequency” parameter are device-specific, and may 
or may not be available for editing, depending on the device code specified. 
 

§ The “ICC Mode Entry” section is common to most devices. It allows you 
to specify how inDART-STX will enter the ICC mode. You can choose to use 
the Option Bytes programmed into the device or to bypass them and use 
the Option Bytes default value instead (the value that would be used if the 
device is blank). 
In the former case, you must provide the required clock source (specified in 
the Option Bytes value programmed into the device)—otherwise the device 
won’t work. 
In the latter case, the device is assumed to be blank, and forced to use its 
default Option Bytes value. This means, among other things, that a “safe” 
clock source is used (typically an external clock must be provided). This 
option (which is used by inDART-STX by default) is useful when the 
Option Bytes value programmed into the device specify incorrect start-up 
parameters; you can bypass them and start-up from a safe condition. 

§ The “Target RESET Rise Time” parameter, if available, is used by 
inDART-STX to synchronize the ICCSEL/VPP signal timings with respect to 
the RESET signal. On some devices (e.g. ST72F621) the ICCSEL/VPP line 
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must be appropriately driven, during the RESET phase, after the RESET 
line becomes high, but before a certain amount of time elapses. The 
diagram below illustrates how to determine the “Target RESET Rise Time” 
(TRISE) parameter. 

 

 
TRISE Parameter Constraints 

§ The “Embedded Command Frequency” parameter, if available, is 
used by inDART-STX to properly configure some of the target on-chip 
resources. By default, set this parameter to 1. If programming errors are 
detected, this parameter must be increased by steps of 1 up to fCPU to 
increase the programming pulse. 

Device and Option Bytes Settings 
The “Device Code” parameter specifies the target microcontroller used in your 
target application. You must specify the exact device code of the microcontroller 
you are working with. 

The “Set Option Bytes” button allows you to access the Edit Option Bytes 
dialog box. The following figure illustrates an example of the Edit Option Bytes 
dialog box (every microcontroller has its own specific Option Bytes). 
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The Edit Option Bytes dialog box 

Particular attention must be paid in correctly setting each of the Option Bytes 
parameters. Improper settings may cause the target microcontroller not to work 
correctly (or not to work at all).  
 

 
Note: the Option Bytes values specified in the Edit Option Bytes dialog box are 
used when debugging. Additionally, they are also used when programming the 
device (see “Programming Capabilities” below). 
 

Programming Capabilities 

inDART-STX features In-Circuit Programming (ISP) capabilities. A 
programming utility is built-in in the inDART-STX user interface. When in 
Debugging mode, the Tools > Program command in the main menu is 
enabled, and allows you to program the target microcontroller with your target 
application code but without any debugging code (that is, the monitor is not 
programmed—only the application is programmed). A typical programming 
procedure is made of a series of programming steps, as indicated in the figure 
below. You can choose whether to perform or not each single step. Please note 
that the programming steps are performed in the exact order indicated in the 
Program dialog box.  
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The Program Dialog Box 

§ Clear Read-Out Protection. Clears the Read-Out Protection bit. Check 
this programming step when you are programming a device which has been 
programmed with the Read-Out Protection bit set. 

§ Erase Device. Erases the entire Code memory area. 

§ Program FLASH Memory. Writes the application code into the Code 
memory area. 

§ Verify FLASH Memory. Verifies that the application code has been 
correctly written into the Code memory. 

§ Program Option Bytes. Programs the Option Bytes according to the 
parameters specified in the Edit Option Bytes dialog box. 

§ Set Read-Out Protection. Set the Read-Out Protection bit. Check this 
programming step if you want to protect the application code from external 
reading operations. 

§ Run. After programming, resets the microcontroller and executes the 
application program. 
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Note: after programming the device, you will not be able to continue with the 
current debugging session. To continue debugging, you must stop the current 
debugging session and start a new one. This happens because the monitor has 
not been programmed with the application. 
 

DataBlaze Programming Utility 

A standalone, full-featured programming utility (DataBlaze) is also provided 
with inDART-STX. To start the DataBlaze utility select Start > Programs > 
SofTec Microsystems > inDART-STX > ST7 > DataBlaze 
Programmer. 
DataBlaze offers the following advanced features: 
 
§ Code memory editing; 
§ Data memory (EEPROM) editing; 

§ Blank check/erase/verify operations on Code memory, Data memory and 
Option Bytes; 

§ Read operations from Code memory, Data memory and Option Bytes; 
§ Project handling; 
§ One-button, multiple-operation programming (“Auto” feature); 
§ Serial numbering. 
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4. Troubleshooting 

Common Problems and Solutions 

This section reports some common problems that may arise during general use. 
However, working with a specific target device may cause device-specific issues. 
Please refer to the inDART-STX online user’s manual addendum for detailed, 
device-specific information. 

Communication can’t be established with inDART-STX 
1. Make sure the inDART-STX in-circuit debugger is connected to the PC and 

powered on. inDART-STX is powered by the USB connection.  

2. Make sure you are working with the correct inDART hardware model. To 
view/change the inDART hardware model in use, choose Tools > MCU 
Configuration from the inDART-STX user interface’s main menu. 

3. Make sure the demo board/target application board is powered on and the 
target microcontroller is working. Programming and debugging rely on an 
ICC serial communication between the inDART-STX board and the demo 
board/target application. This means that, in order to work correctly, the 
target microcontroller must be running. In particular, make sure that: 
 

§ The ISP cable is connected to the demo board/target application’s ISP 
connector. 

§ The target microcontroller is in place. 

§ All of the ISP connector signals (ICCDATA, ICCCLK, ICCSEL/VPP, 
OSC_CLK, RESET, VDD and VSS) are correctly tied to the target 
microcontroller. 

§ The oscillator circuitry is working according to the Option Bytes 
specifications. To view/change the Option Bytes, choose Tools > MCU 
Configuration from the inDART-STX user interface’s main menu. 
From the dialog box which will appear, click the “Set Option Bytes” 
button. 
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A communication error is returned on a program execution command (Run, 
Continue, Step, etc.) 
Make sure that the I/O bits corresponding to the ICCDATA and ICCCLK signals 
are set to input mode by your program. 

The program execution stops at the beginning of user’s code 
A Reset condition occurred. This can be due to an external Reset condition 
(microcontroller’s RESET line driven low) or an internal Reset condition (e.g., 
due to a Watchdog event). For more information on causes that can trigger a 
Reset condition, please refer to the specific ST7 microcontroller device data 
sheet. 

Diagnostic Test 

inDART-STX has built-in self-test capabilities. This means that you can verify 
by yourself, at any time, the correct operation of the instrument’s hardware. The 
diagnostic test is accessible through a small, separate test utility. To perform the 
diagnostic test: 
 
1. Start the inDART-STX diagnostic test utility by selecting Start > 

Programs > SofTec Microsystems > inDART-STX > ST7 > 
Diagnostic Test. The following dialog box will appear. 

 

 
The inDART-STX Diagnostic Test Utility 

 
2. Make sure that inDART-STX is connected to the host PC; 
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3. Make sure that no target system is connected to inDART-STX; 

4. Click “OK”. The test will be performed. In case of problems, please contact 
our technical support. 

Getting Technical Support 

Technical assistance is provided free to all customers. For technical assistance, 
documentation and information about products and services, please refer to 
your local SofTec Microsystems partner. 

To benefit the free technical support service, the Registration Card must have 
been filled out and sent in. 

SofTec Microsystems offers its customers a free technical support service at 
support@softecmicro.com. Before to get in contact with us we suggest you, 
however, to visit our online FAQ section and to be sure you are working with the 
latest version of the inDART-STX user interface (upgrades are available for free 
at http://www.softecmicro.com/download.html).
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Appendix A. Electrical and 
Physical Specifications 

Operating Voltage 5 V DC (provided by the USB connection) 
 

Power Consumption 150 mA (max) 
 

VDD Range (Operating Target 
Voltage Supplied to VDD ISP 

Line) 

1.8 V to 5.5 V 

IDD (Current Drawn from the 
Target via the VDD ISP Line) 

10 mA (max) 
 

OSC Signal Characteristics 
(OSC ISP Line) 

4 MHz or 8 MHz, VSS to VDD, 50% duty cycle 

Dimensions 95 x 55 x 15 mm 
 

Weight 25 g 
 

Operating Temperature  0 °C to 50 °C 
 

Storage Temperature  -20 °C to 70 °C 
 

Humidity 90% (without condensation) 

Electrical and Physical Specifications 
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Important 
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1 1. XFlash Devices (without On-
Chip Debug Module) Specific 
Topics 

Introduction 

This chapter details some specific issues that must be known when working with 
the following devices: 
 
§ ST72F260 
§ ST72F262 
§ ST72F264 
§ ST7FLITE02 
§ ST7FLITE05 
§ ST7FLITE09 
§ ST7FLITES2 
§ ST7FLITES5 
 
These devices are based on XFlash technology (EEPROM-based, byte per byte 
reprogrammable, byte per byte erasable) and do not feature an on-chip Debug 
Module. Debugging capabilities are therefore added through a small program 
(monitor) which is automatically and transparently added to the user code and 
programmed into the target microcontroller. The monitor code has been 
developed by SofTec Microsystems. 
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Note: the behaviour and limitations of inDART-STX described in this chapter 
only refer to debugging sessions dedicated to the above listed devices, and do 
not hold for other target devices. 
 

Limitations 

Some target on-chip resources are wasted for debugging purposes. In particular: 
 
§ 7 stack levels (bytes) are wasted. 
§ 180 bytes are reserved for the monitor  (from address FF28H to address 

FFDCH). 
§ ICCDATA and ICCCLK lines are reserved for programming and in-circuit 

debugging. Therefore, in the user application software, associated register 
bits in the port registers must always be masked to avoid conflict with the 
debugger. 

§ The TRAP instruction and the TRAP interrupt vector are reserved for the 
monitor. 

§ Peripherals run even in STOP mode. 

Breakpoint Notes 

inDART-STX can handle an unlimited number of breakpoints within program 
memory. When you set a breakpoint on a source code line, inDART-STX 
automatically (and transparently) replaces the opcode of the instruction where 
the breakpoint is set with the opcode of the TRAP instruction (this explains why 
the TRAP instruction—and the TRAP vector—is reserved and should not be used 
in user applications). 
The difference between inDART-STX and a standard emulator is that the latter 
can set/reset breakpoints under all conditions, while inDART-STX (since it 
needs to change the opcode of the instruction where the breakpoint is set with 
the TRAP instruction) needs to program the FLASH memory of the target 
microcontroller to perform this operation. To program the FLASH memory, 
inDART-STX needs to enter the ISP mode and, consequently, to reset the target 
microcontroller. inDART-STX actually programs breakpoints only when an 
execution command that resets the target microcontroller (e.g., the “Run” 
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1 command) is issued. In all of the other cases breakpoint information is stored 
inside the host PC, program execution switches to “step mode” (see below) and 
breakpoint programming occurs next time an execution command that resets 
the target microcontroller is issued. 

Program Execution Notes  

inDART-STX executes in real-time mode or in step mode. 
 
§ Step mode execution occurs when you launch the emulation, the emulation 

stops due to a breakpoint, then you set/modify breakpoints, and then 
continue the emulation; step mode also occurs when executing step 
commands. 

§ Real-time execution occurs in all other cases. 
 
The following table summarizes (for the most common emulation commands) 
which command causes inDART-STX to execute in real-time mode or in step 
mode. 
 

  Emulation Command Execution Mode 

  Run Real-time 

  Restart Real-time 

  Continue 
 

Real-time if no breakpoints have been set/modified since a 
breakpoint has been encountered, step mode otherwise 

  Step Into Step mode 

  Step Over Step mode 

  Step Out Step mode 

  Run to Cursor Step mode 

Execution Mode Summary 

The following FSM (Finite State Machine) diagram illustrates in detail the 
behaviour of inDART-STX. In the diagram, each state transition is caused by 
one or more events, explained below. 
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1 § Reset. The Reset event is caused by the “Chip Reset” command, an 
external Reset event, or a peripheral Reset event. 

§ Restart. Include either the “Run” command or the “Restart” command. 
§ Stop. The Stop event is caused by the “Stop Program” command. 
§ Breakpoint Hit. This event is caused by a breakpoint hit. 
§ Continue. Is caused by the “Continue” command. 
§ Single-Step Command. Is caused by the “Step Into” and “Step Into 

ASM” commands. 
§ Multiple-Step Command. One of the following commands: “Step Out”, 

“Step Over”, “Step Over ASM”, “Run To Cursor”. Please note that, in 
some cases, the “Step Over” and “Step Over ASM” commands have the 
same effect of the “Step Into” and “Step Into ASM” commands, 
respectively, depending on whether there is a function call to be executed or 
not. 

§ Modify Breakpoints. One of the following commands: 
“Insert/Remove Breakpoint”, “Enable/Disable Breakpoint”, 
“Remove All Breakpoints”. 

§ Edit Data/Registers. One of the following events: memory editing, 
registers editing, watch variables editing, peripherals editing, Program 
Counter editing. 
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1 

 
inDART-STX Execution Modes 

 
Note: user application RESET is not guaranteed to work under all 
circumstances. 
 

Real-Time Execution 
When inDART-STX runs in real time, instructions are executed just as the 
microcontroller would without the debugger. inDART-STX executes in real time 
until a breakpoint is encountered. Subsequent “Continue” commands are still 
performed in real time only if you do not set/modify breakpoints. 

Step Mode Execution 
In step mode, program execution is supervised by the host PC and performed 
(automatically) step by step. 
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Note: in step mode, peripherals are still truly handled by the target 
microcontroller. However, interrupts are not handled (that is, interrupt events 
never occur). This affects execution of instructions like WFI and HALT—since 
these instructions require interrupts to work, in step mode their behaviour is 
different than in real-time mode. In particular, the WFI instruction loops 
forever on itself (no interrupts ever occur), and after executing an HALT 
instruction, program execution cannot continue (same reason). 
 
 

 
Note: in step mode, program execution speed is affected by the host PC 
speed—in particular, in step mode, program execution is slower than real-time 
program execution. This can affect the program execution speed when, for 
example, commands such as “Step Over”, “Step Out” or “Run to Cursor” 
are executed, since it can take a long time to perform the action (especially 
when the code contains loops to be executed many times). 
 

ST7 Product Identifier 
The first execution command occuring after the Reset state causes the first two 
RAM locations to be loaded with an ST7 Product Identifier. This code is device-
specific: the first three nibbles of this identifier give the ST product code, while 
the fourth nibble gives the System Memory revision for the device. 

Online Assembler Notes 

During a debugging sessions, every time assembly instructions are modified in 
the Assembly window (through the Online Assembler), a reset condition occurs 
(even though the Program Counter arrow still points to the same instruction). 
Subsequent debugging commands will be therefore executed from a reset state. 

Stop Execution Notes 

During debugging, user program execution will stop if one of the following 
conditions occur: 
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1 1. A breakpoint has been encountered (or a TRAP instruction has been 
executed); 

2. The microcontroller RESET line has been driven active; 
3. A microcontroller internal RESET state has been triggered (by, for example, 

a Watchdog event, or an internal low-voltage detection); 
4. The “Stop Program” emulation command has been issued from the 

inDART-STX user interface. 
 

 
Note (ST7FLITE0- and ST7FLITES-specific): when in real-time 
emulation, the “Stop Program” command causes a chip reset. 
  

Option Bytes 

Particular attention must be paid in correctly setting each of the Option Bytes 
parameters. Improper settings (and improper setting combinations) may cause 
the target microcontroller not to work correctly (or not to work at all). For 
example, “PLLx2 Enabled” programmed with a 16 MHz resonator on the 
application or “External Source” programmed with a resonator on the 
application. 
If the Option Bytes are programmed with a wrong combination, you will no 
longer be able to access the device, so you must set the “ICC Entry Mode” 
parameter to “Ignore Option Bytes” and then, if the application board hasn’t an 
oscillator or a logic clock, the OSC_CLK pin from the ISP connector must be 
connected to the application board. 
For detailed information on the meaning of the “ICC Entry Mode” parameter 
please refer to the “Appendix A: ICC Entry Mode Details”. 
 

 
Note (ST7FLITE0- and ST7FLITES-specific): when debugging, the 
“WDG_SW (Watchdog Activation)” bit of the Option Bytes must be set to 
“Software”. After setting this bit to “Hardware”, setting it back to “Software” 
only succeeds if the “ICC Mode Entry” parameter is set to “Ignore Option 
Bytes”. 
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1 Troubleshooting 

This section reports some device-specific problems that may arise when working 
with the target devices covered in this chapter. Please refer to the inDART-STX 
user’s manual for general troubleshooting hints. 

LITE0- and ST7FLITES-Specific: Communication can’t be established with 
inDART-STX 
If the “WDG_SW (Watchdog Activation)” bit of the Option Bytes has been set to 
“Hardware” and the “ICC Mode Entry” parameter is set to “Use Option Bytes”, 
you may experience communication problem. In this case, set the “ICC Mode 
Entry” parameter to “Ignore Option Bytes”, and make sure to provide an 
external clock source to the target microcontroller. 

When debugging, the program runs too slowly 
This problem can have two causes: 
 
§ If not correctly set (via Option Bytes), the target microcontroller may run at 

a frequency lower than that specified. In this conditions, the low working 
frequency affects the ICC communication and, therefore, the inDART-STX 
user interface performances. 

§ Under some conditions, program execution is not performed in real time. 
As a consequence, program execution may slow down.  

The program execution stops at the beginning of user’s code 
A Reset condition occurred. This can be due to an external Reset condition 
(microcontroller’s RESET line driven low) or an internal Reset condition (e.g., 
due to a Watchdog event). For more information on causes that can trigger a 
Reset condition, please refer to the specific ST7 microcontroller device data 
sheet. 
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Note (ST7FLITE0- and ST7FLITES-specific): when executing in real-
time, a “Stop Program” command causes a Reset condition. 
 

The program seems not to work correctly 
When debugging your program, some target microcontroller’s resources are 
reserved for debugging purposes. In particular, 180 bytes are reserved for the 
monitor (from address FF28H to address FFDCH). Therefore, you must pay 
attention that your program doesn’t use this range of memory locations. Also, 
please remember that 7 stack levels are reserved as well. 

Interrupt handling routines are not executed 
Under some conditions, program execution is not performed in real time. As a 
consequence, interrupts are not handled. 
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2. XFlash Devices (with On-Chip 
Debug Module) Specific Topics 

Introduction 

This chapter details some specific issues that must be known when working with 
the following devices: 
 
§ ST7FDALI 
§ ST7FLITE10 
§ ST7FLITE15 
§ ST7FLITE19 
§ ST7FLITE20 
§ ST7FLITE25 
§ ST7FLITE29 
§ ST7FLITEBC 
 
These devices are based on XFlash technology (EEPROM-based, byte per byte 
reprogrammable, byte per byte erasable), and do include an on-chip Debug 
Module which allows for basic debugging capabilities (breakpoint handling, 
start/stop user program, etc.). 
 

 
Note: the behaviour and limitations of inDART-STX described in this chapter 
refer to debugging sessions dedicated to the above mentioned devices, and do 
not hold for other target devices. 
 

Limitations 

Some target on-chip resources are wasted for debugging purposes. In particular: 
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§ 5 stack levels (bytes) are wasted. 
§ ICCDATA and ICCCLK lines are reserved for programming and in-circuit 

debugging. 
§ The TRAP instruction and the TRAP interrupt vector are reserved for the 

on-chip Debug Module. 
§ The DM peripheral (the on-chip Debug Module) is reserved (DM registers 

must not be written to by the user application; if read from, the data 
returned is undefined). 

§ Peripherals run even in STOP mode. 
§ The “WDG SW” bit in the Option Bytes must be set to “software watchdog”. 

Breakpoint Notes 

inDART-STX can handle a maximum of two breakpoints within program 
memory. Since these two breakpoints are handled by the on-chip Debug 
Module, inDART-STX always executes in real time.  

Instruction Breakpoints and Advanced Breakpoints 
When working with devices with on-chip Debug Module, advanced breakpoints 
are available. Advanced breakpoints differ from instruction breakpoints (that is, 
standard breakpoints) in that they can stop program execution depending on 
complex situations. Advanced breakpoints allow you, for example, to stop 
execution when a specific value is written to a specific address, or when two 
specified opcodes are fetched sequentially. To set advanced breakpoints, choose 
Emulator > Advanced Break from the main menu (a debugging session 
must have been started). The following dialog box will appear. 
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The Advanced Breakpoints Dialog Box 

When using breakpoints (either instruction breakpoints or advanced 
breakpoints), be aware of the following: 
 
§ You can use advanced breakpoints or instruction breakpoints, but not a 

combination of the two; 
§ As soon as a complex breakpoint is set, previously set instruction 

breakpoints are automatically disabled—and vice versa; 
§ Step commands (Step Into, Step Over, Step Out, Run to Cursor) waste one 

instruction breakpoints. When issuing a step command, all previously set 
instruction or advanced breakpoints are disabled, the step command is 
executed, and then previously set instruction or advanced breakpoints are 
re-enabled. 

 

 
Note: if an advanced breakpoint is set which specifies anything but an 
instruction fetch, then program execution stops after the instruction during 
which the breakpoint condition is met is executed. 
 
 
The following table summarizes the available advanced breakpoints. 
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Breakpoint Type Required Parameters 

Break on data value at a given 
address 

The type of data access (write, read, read/write); 
The address; 
The data value. 
 

Break on opcode fetch within 
address range 

The address at the beginning of the range; 
The address at the end of the range. 
 

Break on data access within 
address range 
 

The type of data access (write, read, read/write); 
The address at the beginning of the range; 
The address at the end of the range. 
 

Break on opcode fetch outside of 
an address range 

The address at the beginning of the range; 
The address at the end of the range. 
 

Break on data access outside of 
an address range 

The type of data access (write, read, read/write); 
The address at the beginning of the range; 
The address at the end of the range. 
 

Break on two sequential opcode 
fetches 

The first opcode fetch; 
The second opcode fetch. 
 

Break on data access at one of 
two addresses 

The type of data access (write, read, read/write); 
The first of the two addresses; 
The second of the two addresses. 
 

Break on opcode fetch or data 
access at given addresses 

The type of data access (write, read, read/write); 
The address where the opcode fetch must occur; 
The address where the data access must occur. 
 

Break on conditional stack write or 
opcode fetch at given address 

The maximum stack address below which the write operation must 
occur; 
The address where the opcode fetch must occur. 
 

Break on conditional stack write or 
data access at given address 

The type of data access (write, read, read/write); 
The address where the data access must occur; 
The maximum stack address below which the write operation must 
occur. 

Advanced Breakpoints Summary 

Advanced Breakpoints Limitations 
The Advanced Breakpoint dialog box allows you to configure breakpoints with a  
large range of possibilities and combinations. However, due to current silicon 
limitations, some restrictions apply. 
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§ Never set a breakpoint on data value/access with the data access type set to 
Read or Read/Write, as an unexpected break may occur (the user 
application could be stopped at a location different from the one specified in 
the breakpoint settings). All the different types of breakpoint on data are 
concerned: 
 
-  Break on data value at a given address; 
-  Break on data access within address range; 
-  Break on data access outside of an address range; 
-  Break on data access at one of  two addresses; 
-  Break on conditional stack write or data access at given address. 
 
Workaround: use instruction breakpoints instead. 
 
Note: setting a breakpoint on data value/access with the data access type set 
to Write does not lead to any unexpected break.  
 

§ Never set a breakpoint on data value/access within the stack area or just 
after the stack area with the data access type set to Read or Read/Write, as 
an unexpected break may occur (the user application could be stopped at a 
location different from the one specified in the breakpoint settings). All the 
different types of breakpoint on data (as above) are concerned. 
 
Workaround: check any stack overflow, use the dedicated advanced 
breakpoints, break on conditional stack write. 
 
Note: setting a breakpoint on data value/access within the stack area or just 
after the stack area with the data access type set to Write does not lead to 
any unexpected break. 

ST7 Product Identifier 

The first execution command occuring after the Reset state causes the first two 
RAM locations to be loaded with an ST7 Product Identifier. This code is device-
specific: the first three nibbles of this identifier give the ST product code, while 
the fourth nibble gives the System Memory revision for the device. 
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Online Assembler Notes 

During a debugging sessions, every time assembly instructions are modified in 
the Assembly window (through the Online Assembler), a reset condition occurs 
(even though the Program Counter arrow still points to the same instruction). 
Subsequent debugging commands will be therefore executed from a reset state. 

Stop Execution Notes 

During debugging, user program execution will stop if one of the following 
conditions occur: 
 
1. A breakpoint has been encountered; 
2. The microcontroller RESET line has been driven active; 
3. A microcontroller internal RESET state has been triggered (by, for example, 

a Watchdog event, or an internal low-voltage detection); 
4. The “Stop Program” emulation command has been issued from the 

inDART-STX user interface. 

Option Bytes 

Particular attention must be paid in correctly setting each of the Option Bytes 
parameters. Improper settings (and improper setting combinations) may cause 
the target microcontroller not to work correctly (or not to work at all). For 
example, if “OSCRANGE” is programmed with “External Clock: CLKIN on PB4” 
while the actual clock source is provided on the OSC1 pin, the microprocessor 
will not start at all. 
If the Option Bytes are programmed with a wrong combination, you will no 
longer be able to access the device, so you must set the “ICC Entry Mode” 
parameter to “Ignore Option Bytes” and then, if the application board hasn’t an 
oscillator or a logic clock, the OSC_CLK pin from the ISP connector must be 
connected to the application board. 
For detailed information on the meaning of the “ICC Entry Mode” parameter 
please refer to the “Appendix A: ICC Entry Mode Details”. 
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Troubleshooting 

This section reports some device-specific problems that may arise when working 
with the target devices covered in this chapter. Please refer to the inDART-STX 
user’s manual for general troubleshooting hints. 

When debugging, the program runs too slowly 
If not correctly set (via Option Bytes), the target microcontroller may run at a 
frequency lower than that specified. In this conditions, the low working 
frequency affects the ICC communication and, therefore, the inDART-STX user 
interface performances. 

The program execution stops at an unexpected location 
Advanced breakpoints are enabled. When advanced breakpoints are enabled, 
instruction breakpoints are disabled and the program execution stops as soon as 
an advanced breakpoint condition is met. The stop location may appear to be 
“random”, but is actually consistent with what specified in the Advanced 
Breakpoints dialog box. To view advanced breakpoints active settings, choose 
Emulator > Advanced Break from the main menu. 

The program execution stops at the beginning of user’s code 
A Reset condition occurred. This can be due to an external Reset condition 
(microcontroller’s RESET line driven low) or an internal Reset condition (e.g., 
due to a Watchdog event). For more information on causes that can trigger a 
Reset condition, please refer to the specific ST7 microcontroller device data 
sheet. 
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3. HDFlash Devices (without On-
Chip Debug Module) Specific 
Topics 

Introduction 

This chapter details some specific issues that must be known when working with 
the following devices: 
 
§ ST72F321 
§ ST72F324 
§ ST72F324L (low voltage) 
§ ST72F521 
§ ST72F561 
§ ST72F621 
§ ST72F622 
§ ST72F623 
§ ST72F63B 
§ ST72F651 
§ ST72F652 
 
These devices do not feature an on-chip Debug Module, therefore debugging 
capabilities are added through a small program (monitor) which is 
automatically and transparently added to the user code and programmed into 
the target microcontroller. The monitor code has been developed by SofTec 
Microsystems. 
Additionally, these devices are based on HDFlash technology (FLASH-based, 
programmable byte per byte, erasable by sector), which only allows for a limited 
number of FLASH erase/write operations (typically <100). Each time a 
debugging session is started, the user code is downloaded to the device FLASH 
memory, and one FLASH erase/write cycle is wasted. 
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Note: the behaviour and limitations of inDART-STX described in this chapter 
refer to debugging sessions dedicated to the above mentioned devices, and do 
not hold for other target devices. 
 

Limitations 

Some target on-chip resources are wasted for debugging purposes. In particular: 
 
§ 7 stack levels (bytes) are wasted. 
§ 200 bytes are reserved for the monitor  (from address FF18H to address 

FFDFH). 
§ ICCDATA and ICCCLK lines are reserved for programming and in-circuit 

debugging. Therefore, in the user application software, associated register 
bits in the port registers must always be masked to avoid conflict with the 
debugger. 

§ SPI peripheral and the SPI interrupt vector are reserved, since the SPI I/O 
lines share the ICCDATA and ICCCLK lines (this limitation only applies to 
ST72F321, 324, 324L and 521). 

§ Global interrupts must be enabled to allow the STOP command to be 
implemented (this limitation only applies to ST72F321, 324, 324L and 521). 

§ The TRAP instruction and the TRAP interrupt vector are reserved for the 
monitor. 

§ Peripherals run even in STOP mode. 
 

 
Note: in order to enter the program the FLASH memory of the devices, 
inDART-STX supplies a 12 V DC voltage to the ICCSEL/VPP pin. You should be 
cautious of this high voltage, since it could damage other circuitry connected to 
that pin. 
 

Program Execution Notes  

inDART-STX executes in real-time mode or in step mode. 
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§ Step mode execution occurs when the user program contains one or more 

breakpoints; 
§ Real-time execution occurs in all other cases. 
 
The following table summarizes (for the most common emulation commands) 
which command causes inDART-STX to execute in real-time mode or in step 
mode. 
 

  Emulation Command Execution Mode 

  Run Real-time if no breakpoint is set, step mode otherwise 

  Restart Real-time if no breakpoint is set, step mode otherwise 

  Continue Real-time if no breakpoint is set, step mode otherwise 

  Step Into Step mode 

  Step Over Step mode 

  Step Out Step mode 

  Run to Cursor Step mode 

Execution Mode Summary 

 
Note: user application RESET is not guaranteed to work under all 
circumstances. 
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Tip: real-time execution only occurs when no breakpoints are set. However, 
you can set “low-level” breakpoints (and still get real-time execution) by 
putting the TRAP instruction in your source code. When a TRAP instruction 
is executed, the program stops just as if a breakpoint was set. The advantage 
of using this technique is that you can have as many TRAP instructions (and 
therefore set as many “low-level” breakpoints) and still the program will be 
executed in real-time. However, every time you insert/remove a TRAP 
instruction you need to recompile your program. 
 

Real-Time Execution 
When inDART-STX runs in real time, instructions are executed just as the 
microcontroller would without the debugger. 

Step Mode Execution 
In step mode, program execution is supervised by the host PC and performed 
(automatically) step by step. 
 

 
Note: in step mode, peripherals are still truly handled by the target 
microcontroller. However, interrupts are not handled (that is, interrupt events 
never occur). This affects execution of instructions like WFI and HALT—since 
these instructions require interrupts to work, in step mode their behaviour is 
different than in real-time mode. In particular, the WFI instruction loops 
forever on itself (no interrupts ever occur), and after executing an HALT 
instruction, program execution cannot continue (same reason). 
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Note: in step mode, program execution speed is affected by the host PC 
speed—in particular, in step mode, program execution is slower than real-time 
program execution. This can affect the program execution speed when, for 
example, commands such as “Step Over”, “Step Out” or “Run to Cursor” 
are executed, since it can take a long time to perform the action (especially 
when the code contains loops to be executed many times). 
 

Online Assembler Notes 

During a debugging sessions, you should not modify assembly instructions in 
the Assembly window (through the Online Assembler), because, due to the 
HDFlash memory technology, the byte-by-byte programming is only successful 
if the device is blank. Undesired results may arise otherwise. The same holds for 
the Memory window. 

Stop Execution Notes 

During debugging, user program execution will stop if one of the following 
conditions occur: 
 
1. A breakpoint has been encountered (or a TRAP instruction has been 

executed); 
2. The microcontroller RESET line has been driven active; 
3. A microcontroller internal RESET state has been triggered (by, for example, 

a Watchdog event, or an internal low-voltage detection); 
4. The “Stop Program” emulation command has been issued from the 

inDART-STX user interface. Please note that, during real-time execution, 
the “Stop Program” command only works if interrupts are enabled in the 
user application. This note only applies to ST72F321, 324, 324L and 521. 
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Note (for ST72F321, 324, 324L and 521): when executing in real-time 
mode, the “Stop Program” command only works if interrupts are enabled 
on the user program (the RIM instruction must be present at the beginning of 
user’s code). The RIM instruction is only needed if users want to stop the 
program by using the “Stop Program” from the user interface—and does not 
affect any other debugging feature. In particular, the RIM instruction does 
not affect breakpoints. 
 
 

 
Note (for ST72F621, 622, 623, 63B, 651 and 652): when in real-time 
emulation, the “Stop Program” command causes a chip reset. 
  

Option Bytes 

Particular attention must be paid in correctly setting each of the Option Bytes 
parameters. Improper settings may cause the target microcontroller not to work 
correctly (or not to work at all). 
On some devices, if the Option Bytes are programmed with a wrong 
combination, you will no longer be able to access the device. If this happens,you 
must set the “ICC Entry Mode” parameter to “Ignore Option Bytes” (note: this 
setting is not available for all devices) and then, if the application board hasn’t 
an oscillator or a logic clock, the OSC_CLK pin from the ISP connector must be 
connected to the application board. 
For detailed information on the meaning of the “ICC Entry Mode” parameter 
please refer to the “Appendix A: ICC Entry Mode Details”. 

Troubleshooting 

This section reports some device-specific problems that may arise when working 
with the target devices covered in this chapter. Please refer to the inDART-STX 
user’s manual for general troubleshooting hints. 

When debugging, the program runs too slowly 
This problem can have two causes: 
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§ If not correctly set (via Option Bytes), the target microcontroller may run at 

a frequency lower than that specified. In this conditions, the low working 
frequency affects the ICC communication and, therefore, the inDART-STX 
user interface performances. 

§ Under some conditions, program execution is not performed in real time. 
As a consequence, program execution may slow down.  

The “Stop Program” command doesn’t work 
ST72F321-, 324-, 324L- and 521-specific: when executing in real-time mode, the 
“Stop Program” command only works if interrupts are enabled on the user 
program (the RIM instruction must be present at the beginning of user’s code). 
The RIM instruction is only needed if users want to stop the program by using 
the “Stop Program” from the user interface—and does not affect any other 
debugging feature. In particular, the RIM instruction does not affect 
breakpoints. 
Also make sure that your program doesn’t use the SPI peripheral and that the 
I/O bits corresponding to the ICCDATA and ICCCLK signals are set to input 
mode. 

The program execution stops at the beginning of user’s code 
A Reset condition occurred. This can be due to an external Reset condition 
(microcontroller’s RESET line driven low) or an internal Reset condition (e.g., 
due to a Watchdog event). For more information on causes that can trigger a 
Reset condition, please refer to the specific ST7 microcontroller device data 
sheet. 
ST72F621-, 622-, 623-, 63B-, 651- and 652-specific: additionally, when 
executing in real-time, a “Stop Program” command causes a Reset condition. 

The program seems not to work correctly 
When debugging your program, some target microcontroller’s resources are 
reserved for debugging purposes. In particular, 200 bytes are reserved for the 
monitor (from address FF18H to address FFDFH). Therefore, you must pay 
attention that your program doesn’t use this range of memory locations. Also, 
please remember that 7 stack levels are reserved as well. 
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Interrupt handling routines are not executed 
Under some conditions, program execution is not performed in real time. As a 
consequence, interrupts are not handled.
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4. HDFlash Devices (with On-Chip 
Debug Module) Specific Topics 

Introduction 

This chapter details some specific issues that must be known when working with 
the following devices: 
 
§ ST7FLCD1 
§ ST7FMC1 
§ ST7FMC2 
 
These devices are based on HDFlash technology (FLASH-based, programmable 
byte per byte, erasable by sector), which only allows for a limited number of 
FLASH erase/write operations (typically <100). Each time a debugging session 
is started, the user code is downloaded to the device FLASH memory, and one 
FLASH erase/write cycle is wasted. 
 

 
Note: the behaviour and limitations of inDART-STX described in this chapter 
refer to debugging sessions dedicated to the above mentioned devices, and do 
not hold for other target devices. 
 

Limitations 

Some target on-chip resources are wasted for debugging purposes. In particular: 
 
§ 5 stack levels (bytes) are wasted. 
§ 216 bytes are reserved for the monitor (from address FF08H to address 

FFDFH). 
§ ICCDATA and ICCCLK lines are reserved for programming and in-circuit 

debugging. 
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§ The TRAP instruction and the TRAP interrupt vector are reserved for the 
on-chip Debug Module. 

§ The DM peripheral (the on-chip Debug Module) is reserved (DM registers 
must not be written to by the user application; if read from, the data 
returned is undefined). 

§ Peripherals run even in STOP mode. 
§ The “WDG SW” bit in the Option Bytes must be set to “software watchdog”. 
 

 
Note: in order to enter the program the FLASH memory of the devices, 
inDART-STX supplies a 12 V DC voltage to the ICCSEL/VPP pin. You should be 
cautious of this high voltage, since it could damage other circuitry connected to 
that pin. 
 

Breakpoint Notes 

inDART-STX can handle a maximum of two breakpoints within program 
memory. Since these two breakpoints are handled by the on-chip Debug 
Module, inDART-STX always executes in real time.  

Instruction Breakpoints and Advanced Breakpoints 
When working with devices with on-chip Debug Module, advanced breakpoints 
are available. Advanced breakpoints differ from instruction breakpoints (that is, 
standard breakpoints) in that they can stop program execution depending on 
complex situations. Advanced breakpoints allow you, for example, to stop 
execution when a specific value is written to a specific address, or when two 
specified opcodes are fetched sequentially. To set advanced breakpoints, choose 
Emulator > Advanced Break from the main menu (a debugging session 
must have been started). The following dialog box will appear. 
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The Advanced Breakpoints Dialog Box 

When using breakpoints (either instruction breakpoints or advanced 
breakpoints), be aware of the following: 
 
§ You can use advanced breakpoints or instruction breakpoints, but not a 

combination of the two; 
§ As soon as a complex breakpoint is set, previously set instruction 

breakpoints are automatically disabled—and vice versa; 
§ Step commands (Step Into, Step Over, Step Out, Run to Cursor) waste one 

instruction breakpoints. When issuing a step command, all previously set 
instruction or advanced breakpoints are disabled, the step command is 
executed, and then previously set instruction or advanced breakpoints are 
re-enabled. 

 

 
Note: if an advanced breakpoint is set which specifies anything but an 
instruction fetch, then program execution stops after the instruction during 
which the breakpoint condition is met is executed. 
 
 
The following table summarizes the available advanced breakpoints. 
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Breakpoint Type Required Parameters 

Break on data value at a given 
address 

The type of data access (write, read, read/write); 
The address; 
The data value. 
 

Break on opcode fetch within 
address range 

The address at the beginning of the range; 
The address at the end of the range. 
 

Break on data access within 
address range 
 

The type of data access (write, read, read/write); 
The address at the beginning of the range; 
The address at the end of the range. 
 

Break on opcode fetch outside of 
an address range 

The address at the beginning of the range; 
The address at the end of the range. 
 

Break on data access outside of 
an address range 

The type of data access (write, read, read/write); 
The address at the beginning of the range; 
The address at the end of the range. 
 

Break on two sequential opcode 
fetches 

The first opcode fetch; 
The second opcode fetch. 
 

Break on data access at one of 
two addresses 

The type of data access (write, read, read/write); 
The first of the two addresses; 
The second of the two addresses. 
 

Break on opcode fetch or data 
access at given addresses 

The type of data access (write, read, read/write); 
The address where the opcode fetch must occur; 
The address where the data access must occur. 
 

Break on conditional stack write or 
opcode fetch at given address 

The maximum stack address below which the write operation must 
occur; 
The address where the opcode fetch must occur. 
 

Break on conditional stack write or 
data access at given address 

The type of data access (write, read, read/write); 
The address where the data access must occur; 
The maximum stack address below which the write operation must 
occur. 

Advanced Breakpoints Summary 

Online Assembler Notes 

During a debugging sessions, every time assembly instructions are modified in 
the Assembly window (through the Online Assembler), a reset condition occurs 
(even though the Program Counter arrow still points to the same instruction). 
Subsequent debugging commands will be therefore executed from a reset state. 
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Stop Execution Notes 

During debugging, user program execution will stop if one of the following 
conditions occur: 
 
1. A breakpoint has been encountered; 
2. The microcontroller RESET line has been driven active; 
3. A microcontroller internal RESET state has been triggered (by, for example, 

a Watchdog event, or an internal low-voltage detection); 
4. The “Stop Program” emulation command has been issued from the 

inDART-STX user interface. 

Option Bytes 

Particular attention must be paid in correctly setting each of the Option Bytes 
parameters. Improper settings (and improper setting combinations) may cause 
the target microcontroller not to work correctly (or not to work at all). 
On some devices, if the Option Bytes are programmed with a wrong 
combination, you will no longer be able to access the device. If this happens, you 
must set the “ICC Entry Mode” parameter to “Ignore Option Bytes” (note: this 
setting is not available for all devices) and then, if the application board hasn’t 
an oscillator or a logic clock, the OSC_CLK pin from the ISP connector must be 
connected to the application board. 
For detailed information on the meaning of the “ICC Entry Mode” parameter 
please refer to the “Appendix A: ICC Entry Mode Details”. 

Troubleshooting 

This section reports some device-specific problems that may arise when working 
with the target devices covered in this chapter. Please refer to the inDART-STX 
user’s manual for general troubleshooting hints. 

When debugging, the program runs too slowly 
If not correctly set (via Option Bytes), the target microcontroller may run at a 
frequency lower than that specified. In this conditions, the low working 
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frequency affects the ICC communication and, therefore, the inDART-STX user 
interface performances. 

The program execution stops at an unexpected location 
Advanced breakpoints are enabled. When advanced breakpoints are enabled, 
instruction breakpoints are disabled and the program execution stops as soon as 
an advanced breakpoint condition is met. The stop location may appear to be 
“random”, but is actually consistent with what specified in the Advanced 
Breakpoints dialog box. To view advanced breakpoints active settings, choose 
Emulator > Advanced Break from the main menu. 

The program execution stops at the beginning of user’s code 
A Reset condition occurred. This can be due to an external Reset condition 
(microcontroller’s RESET line driven low) or an internal Reset condition (e.g., 
due to a Watchdog event). For more information on causes that can trigger a 
Reset condition, please refer to the specific ST7 microcontroller device data 
sheet. 
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Appendix A: ICC Mode Entry 
Details 

The “ICC Mode Entry” parameter allows you to specify how inDART- STX will 
enter the ICC mode. You can choose to use the Option Bytes programmed into 
the device or to bypass them and use a “forced” value instead. The explanation 
which follows replaces the one given in the printed inDART-STX for ST7 user’s 
manual. 
 

 
The Settings Dialog Box 

In the former case (“Use Option Bytes”), you must provide the required clock 
source (specified in the Option Bytes value programmed into the device)—
otherwise the device won’t work. 
In the latter case (“Ignore Option Bytes”), a “forced” Option Bytes value is used, 
thus enabling you to recover from an previous incorrect setting. This means, 
among other things, that a “safe” clock source is used (typically an external clock 
must be provided). This option (which is used by inDART-STX by default) is 
useful when the Option Bytes value programmed into the device specifies 
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incorrect start-up parameters; you can bypass them and start-up from a safe 
condition. 
The following diagram illustrates what happens when starting the debug. 
 

 
Start Debugging Sequence 
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Appendix B: RC Calibration 
Notes 

Some devices (ST7FLITE0, LITE1, LITE2, LITES, DALI) contain an internal RC 
oscillator. This oscillator must be calibrated to obtain the frequency required in 
the application. This is done by software writing a calibration value in the RCCR 
(RC Control Register). Whenever the microcontroller is reset, the RCCR returns 
to its default value (FFh)—i.e., each time the device is reset, the calibration value 
must be loaded in the RCCR. Predefined calibration values are stored in some 
FLASH and/or EEPROM locations. 
If RC calibration is not used, these locations can be used as “normal” memory. 
The RC Calibration Locations dialog box, available by clicking the “RC 
Calibration Locations” button in the Settings dialog box (this button is available 
only for devices featuring an internal RC oscillator) allows you to specify, for 
every RC calibration location available, wheter to keep it reserved for calibration 
purposes or to use it as a normal memory location. 
 

 
The RC Calibration Locations Dialog Box 
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